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Safety warning notice

WARNING! To reduce the possibility of heat-related injuries or of overheating the device, do not
place the device directly on your lap or obstruct the device air vents. Use the device only on a hard, flat
surface. Do not allow another hard surface, such as an adjoining optional printer, or a soft surface,
such as pillows or rugs or clothing, to block airflow. Also, do not allow the AC adapter to contact the
skin or a soft surface, such as pillows or rugs or clothing, during operation. The device and the AC
adapter comply with the user-accessible surface temperature limits defined by the International
Standard for Safety of Information Technology Equipment (IEC 60950).
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1 Product description

Category Description

Product Name HP EliteBook 2570p Notebook PC

Processors ● Intel® Dual Core® i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-
MHz FSB, 4.0-MB L3 cache, 35 W)

● Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

● Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

● Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

● Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W)

Chipset Mobile Intel QM77 chipset

Graphics Intel HD Graphics 4000 integrated universal memory architecture (UMA) graphics

Panel 12.5-in light-emitting diode (LED), high-definition (HD), AntiGlare (AG), SVA (1368×768)
display with and without webcam and microphone

All display assemblies include two wireless local area network (WLAN) antenna cables and
two wireless wide area network (WWAN) antenna cables

Support for low voltage differential signalling (LVDS)

Support for optional privacy filter

Memory Two customer-accessible/upgradable memory module slots

Support for DDR3-12800 (1600-MHz) dual channel

Support for 16384-MB of system RAM in the following configurations:

● 16384-MB (8192-MB×2, dual channel)

● 12288-MB (8192-MB×1+4096-MB×1, dual channel)

● 8192-MB (8192-MB×1 or 4096×2, dual channel)

● 4096-MB (4096-MB×1 or 2048-MB×2, dual channel)

● 2048-MB (2048×1)
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Category Description

Hard drive Support for 6.35-cm (2.5-in) hard drives in 9.5-mm (.37-in) and 7.0-mm (.28-in) thicknesses
(all hard drives use the same bracket)

Customer-accessible

Serial ATA

Support for the following hard drives:

● 750-GB, 7200-rpm, 9.5-mm

● 500-GB, 7200-rpm, 7.0-mm self-encrypting drive (SED)

● 500-GB, 7200-rpm, 7.0-mm

● 320-GB, 7200-rpm, 7.0-mm

Solid-state drive Solid-state drive (SSD) mounts in the same bracket as the hard drive

Customer-accessible

Serial ATA type II and III

Support for the following SSDs:

● 256-GB SED III

● 160-GB II

● 128-GB III

Optical drive Fixed

Customer-accessible

Support for the following drive options:

● DVD±RW Double-Layer with SuperMulti Drive

● DVD-ROM Drive

Support for no drive option

Audio and video Two stereo speakers

HD audio with SRS Premium Sound PRO

Integrated 720p HD webcam

Support for no camera option

Integrated dual-array microphone on computer models equipped with a webcam

Integrated mono microphone on computer models not equipped with a webcam

Ethernet Intel 82579LM 10/100/1000 Ethernet network interface card (NIC)

NIC Power Down technology

S3/S4/S5 wake on LAN

Ethernet cable not included
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Category Description

Wireless Integrated wireless personal area network (WPAN) option by way of Bluetooth 4.0 enhanced
data rate (EDR) module

Support for no WPAN option

 Integrated wireless local area network (WLAN) options by way of wireless module

Two WLAN antennas built into display assembly

Support for the following WLAN formats:

● Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter

● Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter

● Intel Centrino Advanced-N 6205 WLAN module

Support for no WLAN option

 Integrated wireless wide area network (WWAN) options by way of wireless module

Two world-wide/5-band WWAN antennas built into display assembly

Secured by subscriber identity module (SIM, user-accessible behind battery)

Support for the following WWAN formats:

● HP lt2523 LTE/HSPA+ Mobile Broadband Module

● HP lt2522 LTE/EV-DO Mobile Broadband Module

● HP un2430 EV-DO/HSPA Mobile Broadband Module

● HP hs2350 HSPA+ Mobile Broadband Module

Support for no WWAN option

Support for WWAN after market option

External media cards 34-mm ExpressCard slot

Integrated Smart Card reader

Secure Digital (SD) Media reader slot with push-push technology, supporting the following
digital card formats:

● MultiMediaCard (MMC)

● MMC+

● Secure Digital (SD) Memory Card

● SDHC

● SDXC

3



Category Description

Ports ● Audio-in (mono microphone)/audio-out (stereo headphone) combo jack

● Battery connector

● DisplayPort 1.1

● Docking connector

● eSATA/USB 3.0 combo port

● HP Smart AC adapter

● RJ-45 (Ethernet)

● RJ-11 (modem)

● USB 3.0 port

● USB 2.0 charging port

● VGA (Dsub 15-pin) supporting: 1920×1200 external resolution @ 75 Hz, hot plug and
unplug and auto-detection for correct output to wide-aspect vs. standard aspect video

Keyboard/pointing
devices

Chiclet-style keyboard with numeric keypad (upper-left justified), dual-point, spill-resistant with
drain, durakeys, backlit (optional)

Gesture support: MultiTouch gestures enabled, two-finger scrolling, and pinch-
zoom as default

Taps enabled by default

Support for TouchPad with image sensor

Support for 2-way scroll

Power requirements Support for the following AC adapters:

● 65-W HP Smart AC adapter (PFC, RC/V, EM, 3-wire)

● 65-W HP Smart AC adapter (non-PFC, RC/V, 3-wire)

● 65-W HP Travel AC adapter (non-PFC, 3-wire)

 Support for the following batteries:

● 9-cell, 100-Wh, 3.00-Ah

● 6-cell, 62-Wh, 2.80-Ah

● 6-cell, 55-Wh, 2.80-Ah

● 3-cell, 31-Wh, 2.80-Ah
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Category Description

Security Support for security cable lock

Support for fingerprint reader and no fingerprint reader option

Support for Trusted Platform Module (TPM) 1.2 (Infineon, soldered down) and TPM Enhanced
Drive Lock (not supported in Asia and the People's Republic of China)

Integrated Smart Card reader (active)

Full volume encryption

Preboot authentication (password, Smart Card)

Operating system Preinstalled:

● Windows® 7 Home Premium 64- and 32-bit with Microsoft Basics

● Windows 7 Professional 64- and 32-bit with Microsoft Basics

● FreeDOS

 Preinstalled with Microsoft Office:

● Windows 7 Home Basic 32-bit with Office Starter (emerging markets only)

● Windows 7 Home Premium 64- and 32-bit with Office Starter (not available in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Personal (only in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Home & Business (only in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Personal (only in Japan)

● Windows 7 Home Premium 64-bit with Office 2010 Professional (only in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Starter (not available
in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Business & Home (only
in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Personal (only in Japan)

● Windows 7 Professional 64- and 32-bit with Office 2010 Professional (only in Japan)

 Restore media—DR-DVD:

● Windows 7

● Windows 7 with Corel WinDVD

 Restore media—OS-DVD:

● Windows 7 Home Basic 32-bit

● Windows 7 Home Premium 64- and 32-bit

● Windows 7 Professional 64- and 32-bit
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Category Description

 Certified:

● Microsoft WHQL

● SuSE Linux Enterprise 64-bit Service Pack 2

 Web-only support:

● Windows XP Pro 32-bit

● Windows 7 Enterprise 64- and 32-bit

● Windows 7 Ultimate 64- and 32-bit

Serviceability End user replaceable parts:

● AC adapter

● Battery

● Hard drive

● Keyboard

● Memory module

● Solid-state drive

● WLAN module

● WWAN module
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2 External component identification

Display

Item Component Description

(1) WLAN antennas (2)* Send and receive wireless signals to communicate
with WLANs (select models only).

(2) WWAN antennas (2)* Send and receive wireless signals to communicate
with WWANs (select models only).

(3) Internal microphones (2) Record sound.

(4) Webcam light (select models only) On: The webcam is in use.

Display 7



Item Component Description

(5) Webcam (select models only) Records video and captures still photographs.

To use the webcam, select Start > All Programs >
Communication and Chat > HP Webcam.

(6) Keyboard light Provides light for the keyboard.

(7) Keyboard light button and ambient
light sensor

Turns on the keyboard light and automatically adjusts the
display brightness based on the lighting conditions in
your environment.

*The antennas are not visible from the outside of the computer. For optimal transmission, keep the areas immediately around
the antennas free from obstructions. To see wireless regulatory notices, see the section of the Regulatory, Safety, and
Environmental Notices that applies to your country or region.
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Buttons and fingerprint reader (select models only)

Item Component Description

(1) Power button ● When the computer is off, press the power button to
turn on the computer.

● When the computer is on, press the power button
briefly to initiate Sleep.

● When the computer is in the Sleep state, press the
power button briefly to exit Sleep.

● When the computer is in Hibernation, press the
power button briefly to exit Hibernation.

CAUTION: Pressing and holding the power button
for emergency shutdown will result in loss of unsaved
information.

If the computer has stopped responding and Windows
shutdown procedures are ineffective, press and hold the
power button for at least 5 seconds to turn off
the computer.

To learn more about your power settings, select
Windows 7 > Start > Control Panel > System
and Security > Power Options, or refer to the HP
Notebook Reference Guide.

(2) Wireless button Turns the wireless feature on or off, but does not establish
a wireless connection.

Buttons and fingerprint reader (select models only) 9



Item Component Description

(3) Web browser button Opens the default Web browser.

(4) Volume mute button Mutes and restores speaker sound.

(5) Fingerprint reader (select models only) Allows a fingerprint logon instead of a password logon.

Keys
NOTE: Your computer may look slightly different from the illustration in this section.

Item Component Description

(1) esc key Displays system information when pressed in combination
with the fn key.

(2) fn key Executes frequently used system functions when pressed
in combination with a function key, the num lk key, the
esc key, or other keys.

(3) Windows logo key Displays the Windows Start menu.

(4) Function keys Execute frequently used system functions when pressed in
combination with the fn key.

(5) Embedded numeric keypad When the keypad is turned on, it can be used like an
external numeric keypad.

NOTE: The embedded numeric keypad will not function
while an external keyboard or numeric keypad is
connected to the computer

(6) Windows applications key Displays a shortcut menu for items beneath the cursor.

10 Chapter 2   External component identification



Lights

Item Component Description

(1) Power light ● White: The computer is on.

● Blinking: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(2) Num lock light White: Num lock is on.

(3) Wireless light ● White: An integrated wireless device, such as a
WLAN device, a WWAN device, and/or a
Bluetooth device, is on.

● Amber: All wireless devices are off.

(4) Web browser light ● On: The computer is on.

● Off: The computer is off or in Hibernation.

(5) Mute light ● White: Computer sound is on.

● Amber: Computer sound is muted.

(6) Caps lock light White: Caps lock is on.

(7) TouchPad on/off light ● Amber: The TouchPad is off.

● Off: The TouchPad is on.
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TouchPad

Item Component Description

(1) Pointing stick Moves the pointer and selects or activates items on
the screen.

(2) Left pointing stick button Functions like the left button on an external mouse.

(3) TouchPad on/off button Turns the TouchPad on or off.

(4) TouchPad zone Moves the pointer and selects or activates items on
the screen.

(5) Left TouchPad button Functions like the left button on an external mouse.

(6) Right pointing stick button Functions like the right button on an external mouse.

(7) Right TouchPad button Functions like the right button on an external mouse.
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Front

Item Component Description

(1) Wireless light ● White: An integrated wireless device, such as a
WLAN device, a WWAN device, and/or a
Bluetooth device, is on.

● Amber: All wireless devices are off.

(2) Power light ● White: Power is on.

● Blinking white: The computer is in the Sleep state.

● Off: The computer is off or in Hibernation.

(3) Battery light ● White: A battery is close to full charge capacity.

● Amber: A battery that is the only available power
source has reached a low battery level. When the
battery reaches a critical battery level, the battery
light begins blinking rapidly.

● Off: If the computer is plugged into an external
power source, the light turns off when all batteries in
the computer are fully charged. If the computer is
not plugged into an external power source, the light
stays off until the battery reaches a low battery level.

(4) Drive light ● White: The hard drive or optical drive is
being accessed.

● Amber: HP 3D DriveGuard has temporarily parked
the hard drive.

(5) Vents (3) Enables airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.
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Left side

Item Component Description

(1) Power connector Connects an AC adapter.

(2) RJ-45 (network) jack Connects a network cable. The RJ-45 jack has two
activity indicator lights.

● Amber: Activity is occurring on the network.

● Green: The network is connected.

(3) RJ-11 (modem) jack (select models only) Connects a modem cable.

(4) Optical drive Reads and writes (select models only) to an optical disc.

(5) Optical drive light ● On: The optical drive is being accessed.

● Off: The optical drive is idle.

(6) Smart Card reader Supports optional smart cards.
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Rear

Item Component Description

(1) External monitor port Connects an external VGA monitor or projector.

(2) USB port Connects an optional USB device.

(3) USB 3.0 port Connects an optional USB 1.0, USB 2.0, or USB 3.0
device and provides enhanced USB power performance
for USB 3.0 devices.
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Right side

Item Component Description

(1) ExpressCard slot Supports optional 34-mm ExpressCards.

(2) Media Card Reader Supports MultiMediaCard and Secure Digital (SD) Card
digital card formats.

(3) Audio-out (headphone) jack/Audio-in
(microphone) jack

Connects optional powered stereo speakers,
headphones, earbuds, a headset, or television audio.
Also connects an optional headset microphone.

WARNING! To reduce the risk of personal injury,
adjust the volume before putting on headphones,
earbuds, or a headset. For additional safety information,
refer to the Regulatory, Safety, and
Environmental Notices..

NOTE: When a device is connected to the jack, the
computer speakers are disabled.

NOTE: A 4-conductor audio jack plug headphone with
microphone is needed in order to use the
microphone function.

(4) DisplayPort Connects an optional digital display device, such as a
high-performance monitor or projector.

(5) eSATA/USB 2.0 combo port Connects a high-performance eSATA component, such as
an eSATA external hard drive, or connects an optional
USB device.

(6) Vents (2) Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(7) Docking connector Connects an optional docking device.

(8) Security cable slot Attaches an optional security cable to the computer.

NOTE: The security cable is designed to act as a
deterrent, but it may not prevent the computer from being
mishandled or stolen.
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Bottom

Item Component Description

(1) Service cover Contains the hard drive, the WLAN module slot, the
WWAN module slot, and the memory module slots.

CAUTION: To prevent an unresponsive system, replace
the wireless module only with a wireless module
authorized for use in the computer by the governmental
agency that regulates wireless devices in your country or
region. If you replace the module and then receive a
warning message, remove the module to restore
computer functionality, and then contact support through
Help and Support.

(2) Service cover release latch Releases the cover for the hard drive bay and memory
module slots.

NOTE: A service cover screw is under the release latch.

(3) Battery bay Holds the battery.

(4) Battery release latch Releases the battery.

(5) SIM slot Supports a wireless subscriber identity module (SIM). The
SIM slot is located inside the battery bay.
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Item Component Description

(6) Vents Enable airflow to cool internal components.

NOTE: The computer fan starts up automatically to cool
internal components and prevent overheating. It is
normal for the internal fan to cycle on and off during
routine operation.

(7) Bluetooth module compartment Holds the Bluetooth device.

(8) Speaker Produces sound.
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Service tag
When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 44 for battery removal instructions.

Item Description Function

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product's hardware components. The part number
helps a service technician to determine what
components and parts are needed.

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.
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Item Component Spare part number

(1) Display assembly: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see Display assembly subcomponents on page 26.

(2) Keyboard with pointing stick (includes keyboard cable and pointing stick cable):

 For use in Belgium 696693-A41

 For use in Brazil 696693-201

 For use in Bulgaria 696693-261

 For use in Canada 696693-DB1

 For use in the Czech Republic and Slovakia 696693-FL1

 For use in Denmark 696693-081

 For use in France 696693-051

 For use in Germany 696693-041

 For use in Greece 696693-151

 For use in Hungary 696693-211

 For use in Iceland 696693-DD1

 For use in India 696693-D61

 For use in Israel 696693-BB1

 For use in Italy 696693-061

 For use in Japan 696693-291

 For use in Latin America 696693-161

 For use in the Netherlands 696693-B31

 For use in Norway 696693-091

 For use in Northwest Africa 696693-FP1

 For use in Portugal 696693-131

 For use in Romania 696693-271

 For use in Russia 696693-251

 For use in Saudi Arabia 696693-171

 For use in Slovenia 696693-BA1

 For use in South Korea 696693-AD1

 For use in Spain 696693-071

 For use in Sweden and Finland 696693-B71

 For use in Switzerland 696693-BG1

 For use in Taiwan 696693-AB1

 For use in Thailand 696693-281
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Item Component Spare part number

 For use in Turkey 696693-141

 For use in the United Kingdom and Singapore 696693-031

 For use in the United States 696693-001

(3) RTC battery (includes cable and double-sided adhesive) 665733-001

(4) Top cover (includes TouchPad and TouchPad cable):

NOTE: The TouchPad cable is also available in the Cable Kit, spare part number 651384-001.

 For use on computer models equipped with a fingerprint reader 685407-001

 For use on computer models not equipped with a fingerprint reader 685406-001

 Bracket Kit (not illustrated includes top cover left and right brackets) 651381-001

(5) Power button board (includes cable) 685408-001

(6) Smart Card reader assembly (includes Smart Card reader cable and function
LED board cable)

685503-001

(7) Function LED board 685509-001

(8) Fingerprint reader board (includes bracket and cable) 685410-001

(9) Function button board (includes cable) 685409-001

(10) System board (includes replacement thermal material):

 For use in all countries and regions except the People's Republic of China 685404-001

 For use only in the People's Republic of China 692857-001

(11) Processor (includes replacement thermal material)

 Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz
FSB, 4.0-MB L3 cache, 35 W)

681954-001

 Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

681953-001

 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

681952-001

 Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz
FSB, 3.0-MB L3 cache, 35 W)

680645-001

 Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001

(12) Heat sink (includes replacement thermal material) 685508-001

(13) Optical drive (includes bezel and bracket):

 DVD±RW Double-Layer with SuperMulti Drive 685502-001

 DVD-ROM Drive 685419-001

(14) Base enclosure (includes 4 rubber feet, battery release latch assembly, service cover
release latch assembly, and replacement thermal material)

685403-001
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Item Component Spare part number

 Latch Kit (not illustrated, includes battery release latch assembly components and
service cover release latch assembly components)

685505-001

 Rubber Kit (not illustrated, includes base enclosure and display bezel screw covers) 651382-001

(15) Battery (Li-ion):

 9-cell, 100-Wh, 3.00-Ah 632423-001

 6-cell, 62-Wh, 2.80-Ah 632421-001

 6-cell, 55-Wh, 2.80-Ah 632419-001

 3-cell, 31-Wh, 2.80-Ah 632417-001

(16) Modem module (56k v.92 MDC data/fax, does not include cable) 

NOTE: The modem module does not include a cable. The modem module cable is
included in the Cable Kit, spare part number 651384-001. See Cable Kit
on page 28 for more Cable Kit information.

628824-001

(17) WWAN module:

 HP lt2523 LTE/HSPA+ Mobile Broadband Module 675793-001

 HP lt2522 LTE/EV-DO Mobile Broadband Module 675791-001

 HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

 HP hs2350 HSPA+ Mobile Broadband Module 668969-001

(18) WLAN module:

 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter 675794-001

 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter 669832-001

 Intel Centrino Advanced-N 6205 WLAN module 631954-001

(19) Speaker assembly (includes cable) 651377-001

(20) Bluetooth module (4.0 EDR)

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module
cable. The Bluetooth module cable is included in the Cable Kit, spare part number
693306-001.

655792-001

(21) Memory modules (2, PC3-12800, 1666-MHz, DDR3):

 8-GB 670034-001

 4-GB 641369-001

 2-GB 652972-001

(22) Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):

 750-GB, 7200-rpm, 9.5-mm 633252-001

 500-GB, 7200-rpm, 9.5-mm self-encrypting drive 683801-001

 500-GB, 7200-rpm, 9.5-mm 634925-001
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Item Component Spare part number

 320-GB, 7200-rpm, 9.5-mm 634862-001

 Hard Drive Hardware Kit (not illustrated, includes hard drive bracket, hard drive
connector adapter, and screws)

651380-001

 Solid-state drive (not illustrated, does not include bracket, connector, or screws):

 256-GB SATA III self-encrypting solid-state drive 697058-001

 160-GB SATA II solid-state drive 697060-001

 128-GB SATA III solid-state drive 697057-001

(23) Fan (includes cable) 651378-001

(24) Service cover 685400-001
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Display assembly subcomponents

Item Component Spare part number

(1) Display bezel:

 For use on computer models equipped with a webcam 685411-001

 For use on computer models not equipped with a webcam 685412-001
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Item Component Spare part number

(2) 12.5 in, HD, LED, AG, SVA display panel 685504-001

 Display Hinge Kit, includes: 685414-001

(3) Left and right display hinges

 Display Hinge Cover Kit, includes: 685405-001

(4a) Left and right display hinge caps

(4b) Left and right display hinge covers

(4c) Display clutch cover

 Antenna Kit, includes: 685506-001

(5a) WLAN antenna cables and transceivers

(5b) WWAN antenna cables and transceivers

(6) Webcam/microphone module 685413-001

 Microphone module 694675-001

 Display Cable Kit, includes: 685417-001

(7) Display panel cable and webcam/microphone module cable

(8) Display enclosure 685415-001

 Display Panel Support Kit (not illustrated, includes display enclosure, WLAN
antenna cables and transceivers, and WWAN antenna cables and transceivers)

685507-001

 Display Screw Kit (not illustrated) 685418-001
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Cable Kit

Item Component Spare part number

 Cable Kit, includes: 651384-001

(1) Bluetooth module cable

(2) Modem module cable
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Mass storage device

Item Description Spare part number

(1) Hard drive (does not include hard drive bracket, hard drive connector adapter, or screws):

 750-GB, 7200-rpm, 9.5-mm 633252-001

 500-GB, 7200-rpm, 9.5-mm SED 683801-001

 500-GB, 7200-rpm, 9.5-mm 634925-001

 320-GB, 7200-rpm, 9.5-mm 634862-001

 Hard Drive Hardware Kit, includes: 651380-001

(2a) Hard drive bracket

(2b) Hard drive connector adapter

 Hard drive bracket screws (not illustrated)

(3) Optical drive (includes bezel and bracket):

 DVD±RW Double-Layer with SuperMulti Drive 685502-001

 DVD-ROM Drive 685419-001

(4) Solid-state drive (does not include bracket, connector adapter, or screws):

 256-GB SATA III self-encrypting solid-state drive 697058-001

 160-GB SATA II solid-state drive 697060-001

 128-GB SATA III solid-state drive 697057-001
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Plastics Kit

Item Component Spare part number

 Plastics Kit, includes: 651376-001

(1) Optical drive bay space saver

(2) ExpressCard slot space saver

(3) RJ-11 jack plug
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Miscellaneous parts

Component Spare part number

AC adapter:

65-W HP Smart AC adapter (PFC, RC/V, EM, 3-wire) 693710-001

65-W HP Smart AC adapter (non-PFC, RC/V, 3-wire) 693711-001

65-W HP Travel AC adapter (non-PFC, 3-wire) 693716-001

Computer carrying case:

HP basic carrying case 455084-001

HP essential nylon carrying case 612757-001

HP professional slim top-load carrying case 592923-001

Computer lock:

HP keyed cable lock 626729-002

HP notebook combination lock 591699-001

Computer mouse:

HP optical/USB travel mouse 434594-001

HP optical/USB/PS2 2-button mouse 390632-001

HP 2570 Docking Station 685401-001

Power cord (3-pin, black, 1.83-m):

For use in Argentina 490371-D01

For use in Australia 490371-011

For use in Brazil 490371-202

For use in Denmark 490371-081

For use in Europe 490371-021

For use in India 490371-D61

For use in Israel 490371-BB1

For use in Japan 490371-291

For use in North America 490371-001

For use in the People's Republic of China 490371-AA1

For use in South Africa 490371-AR1

For use in South Korea 490371-AD1

For use in Switzerland 490371-111

For use in Taiwan 490371-AB1
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Component Spare part number

For use in Thailand 490371-201

For use in the United Kingdom and Singapore 490371-031

Screw Kit 685416-001

Sequential part number listing

Spare part number Description

390632-001 HP USB/PS2 2-button optical mouse

434594-001 HP USB optical travel mouse

455084-001 HP basic carrying case

490371-001 Power cord for use in North America (3-pin, black, 1.83-m)

490371-011 Power cord for use in Australia (3-pin, black, 1.83-m)

490371-021 Power cord for use in Europe (3-pin, black, 1.83-m)

490371-031 Power cord for use in the United Kingdom and Singapore (3-pin, black, 1.83-m)

490371-081 Power cord for use in Denmark (3-pin, black, 1.83-m)

490371-111 Power cord for use in Switzerland (3-pin, black, 1.83-m)

490371-201 Power cord for use in Thailand (3-pin, black, 1.83-m)

490371-202 Power cord for use in Brazil (3-pin, black, 1.83-m)

490371-291 Power cord for use in Japan (3-pin, black, 1.83-m)

490371-AA1 Power cord for use in the People's Republic of China (3-pin, black, 1.83-m)

490371-AB1 Power cord for use in Taiwan (3-pin, black, 1.83-m)

490371-AD1 Power cord for use in South Korea (3-pin, black, 1.83-m)

490371-AR1 Power cord for use in South Africa (3-pin, black, 1.83-m)

490371-BB1 Power cord for use in Israel (3-pin, black, 1.83-m)

490371-D01 Power cord for use in Argentina (3-pin, black, 1.83-m)

490371-D61 Power cord for use in India (3-pin, black, 1.83-m)

591699-001 HP notebook combination lock

592923-001 HP professional slim top-load carrying case

612757-001 HP essential nylon carrying case

626729-002 HP notebook keyed cable lock
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Spare part number Description

628824-001 Modem module (56k v.92 MDC data/fax, does not include cable) 

NOTE: The modem module does not include a cable. The modem module cable is included in the
Cable Kit, spare part number 651384-001. See Cable Kit on page 28 for more Cable Kit
information.

631954-001 Intel Centrino Advanced-N 6205 WLAN module

632417-001 3-cell, 31-Wh, 2.80-Ah, Li-ion battery

632419-001 6-cell, 55-Wh, 2.80-Ah, Li-ion battery

632421-001 6-cell, 62-Wh, 2.80-Ah, Li-ion battery

632423-001 9-cell, 100-Wh, 3.00-Ah, Li-ion battery

633252-001 750-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 651380-001.

634400-001 HP un2430 EV-DO/HSPA Mobile Broadband Module

634925-001 500-GB, 7200-rpm, 9.5-mm hard drive (does not include hard drive bracket, hard drive connector
adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 651380-001.

641369-001 4-GB memory module (PC3, 12800, 1600-MHz)

651376-001 Plastics Kit (includes ExpressCard slot space saver, optical drive bay space saver, RJ-11 jack plug)

NOTE: See Plastics Kit on page 30 for more Plastics Kit information.

651377-001 Speaker assembly (includes cable)

651378-001 Fan (includes cable)

651380-001 Hard Drive Hardware Kit (includes hard drive bracket, hard drive connector adapter, and screws)

651381-001 Bracket Kit (includes top cover left and right brackets)

651382-001 Rubber Kit (includes base enclosure rubber bumpers)

651384-001 Cable Kit (includes Bluetooth module cable and modem module cable)

NOTE: See Cable Kit on page 28 for more Cable Kit information.

652972-001 2-GB memory module (PC3, 12800, 1600-MHz)

655792-001 Bluetooth module 4.0 EDR

NOTE: The Bluetooth module does not include a cable. The Bluetooth module cable is included in
the Cable Kit, spare part number 651384-001. See Cable Kit on page 28 for more Cable Kit
information.

665733-001 RTC battery (includes cable and double-sided adhesive)

668969-001 HP hs2350 HSPA+ Mobile Broadband Module

669832-001 Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter
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Spare part number Description

670034-001 8-GB memory module (PC3, 12800, 1600-MHz)

675791-001 HP lt2522 LTE/EV-DO Mobile Broadband Module

675793-001 HP lt2523 LTE/HSPA+ Mobile Broadband Module

675794-001 Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter

680645-001 Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

681952-001 Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

681953-001 Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-MB
L3 cache, 35 W; includes replacement thermal material)

681954-001 Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0-MB
L3 cache, 35 W; includes replacement thermal material)

682417-001 Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W; includes
replacement thermal material)

683801-001 500-GB, 7200-rpm, 9.5-mm SED hard drive (does not include hard drive bracket, hard drive
connector adapter, or screws)

NOTE: The hard drive bracket, hard drive connector adapter, and screws are included in the
Hard Drive Hardware Kit, spare part number 651380-001.

685400-001 Service cover

685401-001 HP 2570 Docking Station

685403-001 Base enclosure (includes 4 rubber feet, battery release latch assembly, service cover release latch
assembly, and replacement thermal material)

685404-001 System board for use in all countries and regions except the People's Republic of China and the
Ukraine (includes replacement thermal material)

685405-001 Display Hinge Cover Kit (includes left and right display hinge caps, left and right display hinge
covers, and clutch cover)

685406-001 Top cover for use on computer models not equipped with a fingerprint reader (includes TouchPad
and TouchPad cable)

685407-001 Top cover for use on computer models not equipped with fingerprint reader (includes TouchPad and
TouchPad cable)

685408-001 Power button board (includes cable)

685409-001 Function button board (includes cable

685410-001 Fingerprint reader board (includes bracket and cable)

685411-001 Display bezel for use on computer models equipped with a webcam

685412-001 Display bezel for use on computer models not equipped with a webcam

685413-001 Webcam/microphone module

685414-001 Display Hinge Kit (includes left and right display hinges)
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Spare part number Description

685415-001 Display enclosure

685416-001 Screw Kit

685417-001 Display Cable Kit (includes display panel cable and webcam/microphone cable)

685418-001 Display Screw Kit

685419-001 DVD-ROM Drive

685502-001 DVD±RW Double-Layer with SuperMulti Drive

685503-001 Smart Card reader assembly (includes Smart Card reader cable and function LED board cable)

685504-001 12.5 in, HD, LED, AG, SVA display panel

685505-001 Latch Kit (includes battery release latch assembly components and service cover release latch
assembly components)

685506-001 Antenna Kit (includes WLAN antenna cables and transceivers and WWAN antenna cables and
transceivers)

685507-001 Display Panel Support Kit (includes display enclosure with pre-installed WLAN antenna cables and
transceivers and WWAN antenna cables and transceivers)

685508-001 Heat sink (includes replacement thermal material)

685509-001 Function LED board

692857-001 System board for use only in the People's Republic of China and the Ukraine (includes replacement
thermal material)

693710-001 65-W HP Smart AC adapter (PFC, RC/V, EM, 3-wire)

693711-001 65-W HP Smart AC adapter (non-PFC, RC/V, 3-wire)

693716-001 65-W HP Travel AC adapter (non-PFC, 3-wire)

694675-001 Microphone module

696693-001 Keyboard with pointing stick for use in the United States (includes keyboard cable and pointing
stick cable)

696693-031 Keyboard with pointing stick for use in the United Kingdom and Singapore (includes keyboard
cable and pointing stick cable)

696693-041 Keyboard with pointing stick for use in Germany (includes keyboard cable and pointing stick cable)

696693-051 Keyboard with pointing stick for use in France (includes keyboard cable and pointing stick cable)

696693-061 Keyboard with pointing stick for use in Italy (includes keyboard cable and pointing stick cable)

696693-071 Keyboard with pointing stick for use in Spain (includes keyboard cable and pointing stick cable)

696693-081 Keyboard with pointing stick for use in Denmark (includes keyboard cable and pointing stick cable)

696693-091 Keyboard with pointing stick for use in Norway (includes keyboard cable and pointing stick cable)

696693-131 Keyboard with pointing stick for use in Portugal (includes keyboard cable and pointing stick cable)

696693-141 Keyboard with pointing stick for use in Turkey (includes keyboard cable and pointing stick cable)

696693-151 Keyboard with pointing stick for use in Greece (includes keyboard cable and pointing stick cable)
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Spare part number Description

696693-161 Keyboard with pointing stick for use in Latin America (includes keyboard cable and pointing
stick cable)

696693-171 Keyboard with pointing stick for use in Saudi Arabia (includes keyboard cable and pointing
stick cable)

696693-201 Keyboard with pointing stick for use in Brazil (includes keyboard cable and pointing stick cable)

696693-211 Keyboard with pointing stick for use in Hungary (includes keyboard cable and pointing stick cable)

696693-251 Keyboard with pointing stick for use in Russia (includes keyboard cable and pointing stick cable)

696693-261 Keyboard with pointing stick for use in Bulgaria (includes keyboard cable and pointing stick cable)

696693-271 Keyboard with pointing stick for use in Romania (includes keyboard cable and pointing stick cable)

696693-281 Keyboard with pointing stick for use in Thailand (includes keyboard cable and pointing stick cable)

696693-291 Keyboard with pointing stick for use in Japan (includes keyboard cable and pointing stick cable)

696693-A41 Keyboard with pointing stick for use in Belgium (includes keyboard cable and pointing stick cable)

696693-AB1 Keyboard with pointing stick for use in Taiwan (includes keyboard cable and pointing stick cable)

696693-AD1 Keyboard with pointing stick for use in South Korea (includes keyboard cable and pointing
stick cable)

696693-B31 Keyboard with pointing stick for use in the Netherlands (includes keyboard cable and pointing
stick cable)

696693-B71 Keyboard with pointing stick for use in Sweden and Finland (includes keyboard cable and pointing
stick cable)

696693-BA1 Keyboard with pointing stick for use in Slovenia (includes keyboard cable and pointing stick cable)

696693-BB1 Keyboard with pointing stick for use in Israel (includes keyboard cable and pointing stick cable)

696693-BG1 Keyboard with pointing stick for use in Switzerland (includes keyboard cable and pointing
stick cable)

696693-D61 Keyboard with pointing stick for use in India (includes keyboard cable and pointing stick cable)

696693-DB1 Keyboard with pointing stick for use in Canada (includes keyboard cable and pointing stick cable)

696693-DD1 Keyboard with pointing stick for use in Iceland (includes keyboard cable and pointing stick cable)

696693-FL1 Keyboard with pointing stick for use in the Czech Republic and Slovakia (includes keyboard cable
and pointing stick cable)

696693-FP1 Keyboard with pointing stick for use in Northwest Africa (includes keyboard cable and pointing
stick cable)

697057-001 128-GB SATA III solid-state drive

697058-001 256-GB SATA III self-encrypting solid-state drive

697060-001 160-GB SATA II solid-state drive
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4 Removal and replacement
procedures

Preliminary replacement requirements

Tools required

You will need the following tools to complete the removal and replacement procedures:

● Flat-bladed screw driver

● Magnetic screw driver

● Phillips P0 and P1 screw drivers

Service considerations

The following sections include some of the considerations that you must keep in mind during
disassembly and assembly procedures.

NOTE: As you remove each subassembly from the computer, place the subassembly (and all
accompanying screws) away from the work area to prevent damage.

Plastic parts

CAUTION: Using excessive force during disassembly and reassembly can damage plastic parts. Use
care when handling the plastic parts. Apply pressure only at the points designated in the
maintenance instructions.

Cables and connectors

CAUTION: When servicing the computer, be sure that cables are placed in their proper locations
during the reassembly process. Improper cable placement can damage the computer.

Cables must be handled with extreme care to avoid damage. Apply only the tension required to unseat
or seat the cables during removal and insertion. Handle cables by the connector whenever possible. In
all cases, avoid bending, twisting, or tearing cables. Be sure that cables are routed in such a way that
they cannot be caught or snagged by parts being removed or replaced. Handle flex cables with
extreme care; these cables tear easily.
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Drive handling

CAUTION: Drives are fragile components that must be handled with care. To prevent damage to the
computer, damage to a drive, or loss of information, observe these precautions:

Before removing or inserting a hard drive, shut down the computer. If you are unsure whether the
computer is off or in Hibernation, turn the computer on, and then shut it down through the
operating system.

Before handling a drive, be sure that you are discharged of static electricity. While handling a drive,
avoid touching the connector.

Before removing a diskette drive or optical drive, be sure that a diskette or disc is not in the drive and
be sure that the optical drive tray is closed.

Handle drives on surfaces covered with at least one inch of shock-proof foam.

Avoid dropping drives from any height onto any surface.

After removing a hard drive, an optical drive, or a diskette drive, place it in a static-proof bag.

Avoid exposing an internal hard drive to products that have magnetic fields, such as monitors
or speakers.

Avoid exposing a drive to temperature extremes or liquids.

If a drive must be mailed, place the drive in a bubble pack mailer or other suitable form of protective
packaging and label the package “FRAGILE.”

Grounding guidelines

Electrostatic discharge damage

Electronic components are sensitive to electrostatic discharge (ESD). Circuitry design and structure
determine the degree of sensitivity. Networks built into many integrated circuits provide some
protection, but in many cases, ESD contains enough power to alter device parameters or melt
silicon junctions.

A discharge of static electricity from a finger or other conductor can destroy static-sensitive devices or
microcircuitry. Even if the spark is neither felt nor heard, damage may have occurred.

An electronic device exposed to ESD may not be affected at all and can work perfectly throughout a
normal cycle. Or the device may function normally for a while, then degrade in the internal layers,
reducing its life expectancy.
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CAUTION: To prevent damage to the computer when you are removing or installing internal
components, observe these precautions:

Keep components in their electrostatic-safe containers until you are ready to install them.

Before touching an electronic component, discharge static electricity by using the guidelines described
in this section.

Avoid touching pins, leads, and circuitry. Handle electronic components as little as possible.

If you remove a component, place it in an electrostatic-safe container.

The following table shows how humidity affects the electrostatic voltage levels generated by
different activities.

CAUTION: A product can be degraded by as little as 700 V.

Typical electrostatic voltage levels

 Relative humidity

Event 10% 40% 55%

Walking across carpet 35,000 V 15,000 V 7,500 V

Walking across vinyl floor 12,000 V 5,000 V 3,000 V

Motions of bench worker 6,000 V 800 V 400 V

Removing DIPS from plastic tube 2,000 V 700 V 400 V

Removing DIPS from vinyl tray 11,500 V 4,000 V 2,000 V

Removing DIPS from Styrofoam 14,500 V 5,000 V 3,500 V

Removing bubble pack from PCB 26,500 V 20,000 V 7,000 V

Packing PCBs in foam-lined box 21,000 V 11,000 V 5,000 V
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Packaging and transporting guidelines

Follow these grounding guidelines when packaging and transporting equipment:

● To avoid hand contact, transport products in static-safe tubes, bags, or boxes.

● Protect ESD-sensitive parts and assemblies with conductive or approved containers or packaging.

● Keep ESD-sensitive parts in their containers until the parts arrive at static-free workstations.

● Place items on a grounded surface before removing items from their containers.

● Always be properly grounded when touching a component or assembly.

● Store reusable ESD-sensitive parts from assemblies in protective packaging or
nonconductive foam.

● Use transporters and conveyors made of antistatic belts and roller bushings. Be sure that
mechanized equipment used for moving materials is wired to ground and that proper materials
are selected to avoid static charging. When grounding is not possible, use an ionizer to dissipate
electric charges.

Workstation guidelines

Follow these grounding workstation guidelines:

● Cover the workstation with approved static-shielding material.

● Use a wrist strap connected to a properly grounded work surface and use properly grounded tools
and equipment.

● Use conductive field service tools, such as cutters, screw drivers, and vacuums.

● When fixtures must directly contact dissipative surfaces, use fixtures made only of static-
safe materials.

● Keep the work area free of nonconductive materials, such as ordinary plastic assembly aids
and Styrofoam.

● Handle ESD-sensitive components, parts, and assemblies by the case or PCM laminate. Handle
these items only at static-free workstations.

● Avoid contact with pins, leads, or circuitry.

● Turn off power and input signals before inserting or removing connectors or test equipment.
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Equipment guidelines

Grounding equipment must include either a wrist strap or a foot strap at a grounded workstation.

● When seated, wear a wrist strap connected to a grounded system. Wrist straps are flexible straps
with a minimum of one megohm ±10% resistance in the ground cords. To provide proper ground,
wear a strap snugly against the skin at all times. On grounded mats with banana-plug connectors,
use alligator clips to connect a wrist strap.

● When standing, use foot straps and a grounded floor mat. Foot straps (heel, toe, or boot straps)
can be used at standing workstations and are compatible with most types of shoes or boots. On
conductive floors or dissipative floor mats, use foot straps on both feet with a minimum of one
megohm resistance between the operator and ground. To be effective, the conductive must be
worn in contact with the skin.

The following grounding equipment is recommended to prevent electrostatic damage:

● Antistatic tape

● Antistatic smocks, aprons, and sleeve protectors

● Conductive bins and other assembly or soldering aids

● Nonconductive foam

● Conductive tabletop workstations with ground cords of one megohm resistance

● Static-dissipative tables or floor mats with hard ties to the ground

● Field service kits

● Static awareness labels

● Material-handling packages

● Nonconductive plastic bags, tubes, or boxes

● Metal tote boxes

● Electrostatic voltage levels and protective materials

The following table lists the shielding protection provided by antistatic bags and floor mats.

Material Use Voltage protection level

Antistatic plastics Bags 1,500 V

Carbon-loaded plastic Floor mats 7,500 V

Metallized laminate Floor mats 5,000 V
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Component replacement procedures
This chapter provides removal and replacement procedures.

There are as many as 67 screws that must be removed, replaced, and/or loosened when servicing the
computer. Make special note of each screw size and location during removal and replacement.

Service tag

When ordering parts or requesting information, provide the computer serial number and model number
provided on the service tag. It is necessary to remove the battery to obtain these numbers. See Battery
on page 44 for battery removal instructions.

Item Component Description

(1) Product name This is the product name affixed to the front of
the computer.

(2) Serial number (s/n) This is an alphanumeric identifier that is unique to
each product.

(3) Part number/Product number (p/n) This number provides specific information about the
product’s hardware components. The part number helps
a service technician determine what components and
parts are needed.
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Item Component Description

(4) Warranty period This number describes the duration of the warranty
period for the computer.

(5) Model description This is the alphanumeric identifier used to locate
documents, drivers, and support for the computer.

Computer feet

The computer feet are rubber pads that are heat-staked to the base enclosure in the locations
illustrated below.
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Battery

Description Spare part number

9-cell, 100-Wh, 3.00-Ah 632423-001

6-cell, 62-Wh, 2.80-Ah 632421-001

6-cell, 55-Wh, 2.80-Ah 632419-001

3-cell, 31-Wh, 2.80-Ah 632417-001

Before disassembling the computer, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

Remove the battery:

1. Position the computer upside-down on a flat surface, with the battery bay toward you.

2. Slide the battery release latch (1) to release the battery.

3. Remove the battery (2) from the computer.

Install the battery by inserting it into the battery bay until you hear a click. The battery release latch
automatically resets when the battery is installed.
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SIM

NOTE: This section applies only to computer models with WWAN capability.

NOTE: If there is a SIM inserted in the SIM slot, it must be removed before disassembling the
computer. Be sure that the SIM is reinserted in the SIM slot after reassembling the computer.

Before removing the SIM, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44).

Remove the SIM:

1. Press in on the SIM (1). (The SIM partially ejects from the SIM slot.)

2. Remove the SIM (2) from the SIM slot.

Reverse this procedure to install the SIM.

Component replacement procedures 45



Service cover

Description Spare part number

Service cover 685400-001

Before removing the service cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44).

Remove the service cover:

1. Position the computer with the battery bay toward you.

2. Slide the release latch (1) and remove the locking screw (if installed) (2).

3. Slide the release latch (3) to disengage the door from the computer.

4. Remove the service cover (4) by lifting it straight up and away from the computer.

Reverse the removal procedures to install the service cover.
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Memory module

NOTE: Primary and expansion memory is installed in a stacked configuration in the bottom of
the computer.

Description Spare part number

8-GB memory module (PC3, 12800, 1600-MHz) 670034-001

4-GB memory module (PC3, 12800, 1600-MHz) 641369-001

2-GB memory module (PC3, 12800, 1600-MHz) 652972-001

Update BIOS before adding memory modules

Before adding new memory, make sure you update the computer to the latest BIOS.

CAUTION: Failure to update the computer to the latest BIOS prior to installing new memory may
result in various system problems.

To update BIOS:

1. Navigate to www.hp.com.

2. Click Support & Drivers > click Drivers & Software.

3. In the Enter a product name/number box, type the computer model information, and then
click Search.

4. Click the link for the computer model.

5. Select the operating system, and then click Next.

6. Under Step 2: Select a Download, click the BIOS link.

7. Click the link for the most recent BIOS.

8. Click the Download button, and then follow the on-screen instructions.

Before removing a memory module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44).

5. Remove the service cover (see Service cover on page 46).

Remove the memory module:

1. Spread the retaining tabs (1) on each side of the memory module slot to release the
memory module. (The edge of the module opposite the slot rises away from the computer.)
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2. Remove the memory module (2) by pulling the module away from the slot at an angle.

NOTE: The computer uses two memory slots. The top slot houses the expansion memory module.
The bottom slot houses the primary memory module.

Reverse this procedure to install a memory module.

Bluetooth module

NOTE: The Bluetooth module spare part kit does not include a Bluetooth module cable. The Bluetooth
module cable is included in the Cable Kit, spare part number 693306-001.

Description Spare part number

Bluetooth module 655792-001

Before removing a Bluetooth module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44).

5. Remove the service cover (see Service cover on page 46).

Remove the Bluetooth module:

1. Disconnect the Bluetooth module cable (1) from the system board.
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2. Release the Bluetooth module cable (2) from the clip and routing channel built into the
speaker assembly.

3. Lift and rotate the front edge of the Bluetooth module (1) until it disengages from the clip built into
the speaker assembly.

4. Disconnect the Bluetooth module cable (2) from the Bluetooth module.

5. Remove the Bluetooth module (3).

Reverse this procedure to install a memory module.
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Speaker assembly

Description Spare part number

Speaker assembly (includes cable) 651377-001

Before removing the speaker assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

5. Remove the service cover (see Service cover on page 46).

6. Remove the Bluetooth module (see Bluetooth module on page 48)

Remove the speaker assembly:

1. Disconnect the speaker assembly cable (1) from the system board.

2. Remove the Phillips PM2.0×3.6 screw (2) and the two Phillips PM2.0×7.7 screws (3) that secure
the speaker assembly to the base enclosure.

3. Remove the speaker assembly (4).

Reverse this procedure to install the speaker assembly.
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Optical drive

NOTE: The optical drive spare part kit includes the optical drive bezel and optical drive bracket.

Description Spare part number

DVD±RW Double-Layer with SuperMulti Drive 685502-001

DVD-ROM Drive 685419-001

Before removing the optical drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

5. Remove the service cover (see Service cover on page 46).

Remove the optical drive:

1. Position the computer upside-down with the right side toward you.

2. Loosen the captive Phillips screw (1) that secures the optical drive to the computer.

3. Use a flat-blade screw driver or similar tool to press on the optical drive bracket tab (2) to release
the optical drive.

4. Remove the optical drive (3) from the computer.

Reverse this procedure to install the optical drive.
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Hard drive

NOTE: The hard drive spare part kit does not include the hard drive bracket or screws.

Description Spare part number

750-GB, 7200-rpm, 9.5-mm 633252-001

500-GB, 7200-rpm, 9.5-mm SED 683801-001

500-GB, 7200-rpm, 9.5-mm 634925-001

320-GB, 7200-rpm, 9.5-mm 634862-001

Hard Drive Hardware Kit (includes hard drive bracket, hard drive connector adapter, and screws) 651380-001

Before removing the hard drive, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44).

5. Remove the service cover (see Service cover on page 46).

Remove the hard drive:

1. Loosen the four captive Phillips screws (1) that secure the hard drive to the computer.

2. Use the hard drive tab (2) to slide the hard drive toward the front of the computer and disconnect
it from the system board.
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3. Remove the hard drive (3) by lifting it straight up and away from the computer.

4. If it is necessary to disassemble the hard drive, perform the following steps:

a. Position the hard drive with the connector toward you.

b. Disconnect the hard drive connector adapter (1) from the hard drive.

c. Remove the four Phillips PM3.0×3.3 screws (2) that secure the hard drive bracket to the
hard drive.

d. Remove the hard drive bracket (3) from the hard drive.

The hard drive bracket, hard drive connector adapter, and screws are available in the Hard
Drive Hardware Kit, spare part number 651380-001.
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Reverse this procedure to reassemble and install the hard drive.

Fan

Description Spare part number

Fan (includes cable) 651378-001

Before removing the fan, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44).

5. Remove the service cover (see Service cover on page 46).

Remove the fan:

1. Disconnect the fan cable (1) from the system board.

2. Loosen the two captive screws (2) that secure the fan to the top cover.
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3. Remove the fan (3).

Reverse this procedure to install the fan.

WWAN module

NOTE: The WWAN module and the WLAN module are not interchangeable.

Description Spare part number

HP lt2523 LTE/HSPA+ Mobile Broadband Module 675793-001

HP lt2522 LTE/EV-DO Mobile Broadband Module 675791-001

HP un2430 EV-DO/HSPA Mobile Broadband Module 634400-001

HP hs2350 HSPA+ Mobile Broadband Module 668969-001

Before removing the WWAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.
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4. Remove the battery (see Battery on page 44).

5. Remove the service cover (see Service cover on page 46).

Remove the WWAN module:

1. Disconnect the WWAN antenna cables (1) from the terminals on the WWAN module.

NOTE: The red WWAN antenna cable is connected to the WWAN module “Main” terminal.
The blue WWAN antenna cable is connected to the WWAN module “Aux” terminal.
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2. Remove the two Phillips PM2.0×3.0 screw (2) that secures the WWAN module to the
base enclosure. (The WWAN module tilts up.)
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3. Remove the WWAN module (3) by pulling the module away from the slot at an angle.

NOTE: If the WWAN antenna cables are not connected to the terminals on the WWAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WWAN module.
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WLAN module

Description Spare part number

Atheros WB225 1×1 802.11b/g/n Bluetooth Combo Adapter 675794-001

Broadcom 43228 802.11abgn 2×2 Wi-Fi Adapter 669832-001

Intel Centrino Advanced-N 6205 WLAN module 631954-001

CAUTION: To prevent an unresponsive system, replace the wireless module only with a wireless
module authorized for use in the computer by the governmental agency that regulates wireless devices
in your country or region. If you replace the module and then receive a warning message, remove the
module to restore device functionality, and then contact technical support.

Before removing the WLAN module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44).

5. Remove the service cover (see Service cover on page 46).

6. Remove the WWAN module (see WWAN module on page 55).
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Remove the WLAN module:

1. Disconnect the WLAN antenna cables (1) from the terminals on the WLAN module.

NOTE: The WLAN antenna cable labeled “1” connects to the WLAN module “Main” terminal
labeled “1”. The WLAN antenna cable labeled “2” connects to the WLAN module “Aux” terminal
labeled “2”. If the computer is equipped with an 802.11a/b/g/n WLAN module, the yellow
WLAN antenna cable connects to the middle terminal on the WLAN module.

60 Chapter 4   Removal and replacement procedures



2. Remove the two Phillips PM2.0×3.0 screws (2) that secure the WLAN module to the
base enclosure. (The WLAN module tilts up.)

3. Remove the WLAN module (3) by pulling the module away from the slot at an angle.
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NOTE: If the WLAN antenna cables are not connected to the terminals on the WLAN module, the
protective sleeves must be installed on the antenna connectors, as shown in the following illustration.

Reverse this procedure to install the WLAN module.

Modem module

NOTE: The modem module does not include a modem module cable. The modem module cable is
included in the Cable Kit, spare part number 651384-001.

Description Spare part number

Modem module (56k v.92 MDC data/fax) 628824-001

Before removing the modem module, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44).

5. Remove the service cover (see Service cover on page 46).

Remove the modem module:

1. Remove the Phillips PM2.0×3.6 screw (1) that secures the modem module to the system board.

2. Lift the modem module (2) straight up to disconnect it from the system board.
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3. Disconnect the RJ-11 cable (3) from the modem module.

4. Remove the modem module.

Reverse this procedure to install the modem module.

Keyboard

For use in country/region Spare part
number

For use in country/region Spare part
number

Keyboard with pointing stick (includes keyboard cable and
pointing stick cable):

For use in the Netherlands 696693-B31

For use in Belgium 696693-A41 For use in Norway 696693-091

For use in Brazil 693362-201 For use in Northwest Africa 696693-FP1

For use in Bulgaria 696693-261 For use in Portugal 696693-131

For use in Canada 696693-DB1 For use in Romania 696693-271

For use in the Czech Republic
and Slovakia

696693-FL1 For use in Russia 696693-251

For use in Denmark 696693-081 For use in Saudi Arabia 696693-171

For use in France 696693-051 For use in Slovenia 696693-BA1

For use in Germany 696693-041 For use in South Korea 696693-AD1

For use in Greece 696693-151 For use in Spain 696693-071

For use in Hungary 696693-211 For use in Sweden and Finland 696693-B71

For use in Iceland 696693-DD1 For use in Switzerland 696693-BG1

For use in India 696693-D61 For use in Taiwan 696693-AB1

For use in Israel 696693-BB1 For use in Thailand 696693-281

For use in Italy 696693-061 For use in Turkey 696693-141
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For use in country/region Spare part
number

For use in country/region Spare part
number

For use in Japan 696693-291 For use in the United Kingdom
and Singapore

696693-031

For use in Latin America 696693-161 For use in the United States 696693-001

Before removing the keyboard, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44).

5. Remove the service cover (see Service cover on page 46).

6. Remove the fan (see Fan on page 54).

Remove the keyboard:

1. Loosen the three Phillips captive screws that secure the keyboard to the computer.

2. Rest and secure the computer on its left side.

3. Partially open the computer.
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4. Insert a screw driver or similar thin tool into the keyboard release opening in the fan opening, and
then press on the back of the keyboard until the keyboard disengages from the computer.

5. Turn the computer right-side up with the front toward you.

6. Open the computer.

7. Lift the rear edge of the keyboard until the keyboard rests at an angle, and then swing the top
edge of the keyboard up and forward (1) until it rests upside down on the palm rest.

8. Release the zero insertion force (ZIF) connector (2) to which the pointing stick cable is attached,
and then disconnect the pointing stick cable (3) from the system board.

9. Release the ZIF connector (4) to which the keyboard cable is attached, and then disconnect the
keyboard cable (5) from the system board.
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10. Remove the keyboard (6).

Reverse this procedure to install the keyboard.

RTC battery

Description Spare part number

RTC battery (includes cable and double-sided adhesive) 665733-001

Before removing the RTC battery, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Fan (see Fan on page 54)

c. Keyboard (see Keyboard on page 63)
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Remove the RTC battery:

1. Disconnect the RTC battery cable (1) from the system board.

2. Detach the RTC battery (2) from the system board. (The RTC battery is attached to the system
board with double-sided adhesive.)

3. Remove the RTC battery.

Reverse this procedure to install the RTC battery.
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Base enclosure

Description Spare part number

Base enclosure (includes 4 rubber feet, battery release latch assembly, service cover release latch
assembly, and replacement thermal material)

685403-001

Before removing the base enclosure, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Bluetooth module (see Bluetooth module on page 48)

c. Speaker assembly (see Speaker assembly on page 50)

d. Optical drive (see Optical drive on page 51)

e. Hard drive (see Hard drive on page 52)

f. Fan (see Fan on page 54)

g. WWAN module (see WWAN module on page 55)

h. Modem module (see Modem module on page 62)

i. Keyboard (see Keyboard on page 63)
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Remove the base enclosure:

1. Release the ZIF connectors to which the following cables are attached, and then disconnect the
corresponding cables from the system board:

(1) Power button board cable

(2) Fingerprint reader board cable

(3) Function board cable

2. Close the computer.

3. Turn the computer upside down, with the battery bay toward you.
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4. Remove the four Torx TM2.5×8.0 screws that secure the base enclosure to the computer.

5. Remove the three rubber screw covers in the front corners (1) and the right side (2) of the
base enclosure. The rubber screw covers are included in the Rubber Kit, spare part number
651382-001.

6. Remove the five Torx TM2.5×8.0 screws (3) that secure the base enclosure to the computer.
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7. Remove the following screws that secure the base enclosure to the computer:

(1) Three Phillips PM2.0×7.6 screws (two on the front edge of the computer and one in the middle
of the computer)

(2) Two Phillips PM2.0×3.6 screws in the optical drive bay

(3) Three Phillips PM2.0×3.6 screws in the battery bay

8. Lift the rear edge of the base enclosure (1), and then swing the base enclosure up and forward
until the base enclosure detaches from the computer.
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9. Remove the base enclosure (2) from the computer.

10. Remove the base enclosure.

NOTE: When replacing the base enclosure, thoroughly clean the thermal pad material from the
surfaces of the PCH chip (1) and the base enclosure (2). All base enclosure and system board
spare part kits include replacement thermal pad material.

Reverse this procedure to install the base enclosure.
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System board

NOTE: The system board spare part kit includes replacement thermal material.

Description Spare part number

For use in all countries and regions except the People's Republic of China: 685404-001

For use only in the People's Republic of China: 692857-001

Before removing the system board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Bluetooth module (see Bluetooth module on page 48)

c. Speaker assembly (see Speaker assembly on page 50)

d. Optical drive (see Optical drive on page 51)

e. Hard drive (see Hard drive on page 52)

f. Fan (see Fan on page 54)

g. WWAN module (see WWAN module on page 55)

h. Modem module (see Modem module on page 62)

i. Keyboard (see Keyboard on page 63)

j. Base enclosure (see Base enclosure on page 68)

NOTE: When replacing the system board, be sure that the following components are removed from
the defective system board and installed on the replacement system board:

● SIM (see SIM on page 45)

● Memory module (see Memory module on page 47)

● WLAN module (see WLAN module on page 59)

● RTC battery (see RTC battery on page 66)

● Heat sink (see Heat sink on page 75)

● Processor (see Processor on page 78)
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Remove the system board:

1. Remove the ExpressCard slot space saver (1).

2. Release the ZIF connector (2) to which the Smart Card reader assembly cable is connected, and
then disconnect the Smart Card reader assembly cable (3) from the system board.

3. Release the tape (4) that secures the display panel cable to the system board, and then disconnect
the display panel cable (5) from the system board.

4. Release the display panel cable from the clip (6) built into the right display hinge.

5. Release the wireless antenna cables from the retention clip (7) attached to the system board.

6. Remove the Phillips PM2.0×3.6 screw (1) that secures the system board to the top cover.

7. Lift the left side of the system board (2) until it rests at an angle.
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8. Remove the system board (3) by sliding it up and to the left at an angle.

9. Remove the system board.

Reverse this procedure to install the system board.

Heat sink

Description Spare part number

Heat sink (includes replacement thermal material) 685508-001

Before removing the heat sink, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Bluetooth module (see Bluetooth module on page 48)

c. Speaker assembly (see Speaker assembly on page 50)

d. Optical drive (see Optical drive on page 51)

e. Hard drive (see Hard drive on page 52)

f. Fan (see Fan on page 54)

Component replacement procedures 75



g. WWAN module (see WWAN module on page 55)

h. Modem module (see Modem module on page 62)

i. Keyboard (see Keyboard on page 63)

j. Base enclosure (see Base enclosure on page 68)

k. System board (see System board on page 73)

Remove the heat sink:

1. Following the 1, 2, 3, 4 sequence stamped into the heat sink, loosen the four captive Philllips
screws (1) that secure the heat sink to the system board.
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2. Remove the heat sink (2).

NOTE: Due to the adhesive quality of the thermal material located between the heat sink and
the system board components, it may be necessary to move the heat sink from side to side to
detach it.

NOTE: The thermal material must be thoroughly cleaned from the surfaces of the heat sink and
the system board components each time the heat sink is removed. Replacement thermal material is
included with the heat sink and system board spare part kits. Thermal paste is used on the
processor (1) and the heat sink section (2) that services it.
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Reverse this procedure to install the heat sink.

Processor

Description Spare part number

Intel Dual Core i7-3520M 2.90-GHz processor (SC turbo up to 3.60-GHz; 1600-MHz FSB, 4.0-
MB L3 cache, 35 W)

681954-001

Intel Dual Core i5-3360M 2.80-GHz processor (SC turbo up to 3.50-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

681953-001

Intel Dual Core i5-3320M 2.60-GHz processor (SC turbo up to 3.30-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

681952-001

Intel Dual Core i5-3210M 2.50-GHz processor (SC turbo up to 3.10-GHz; 1600-MHz FSB, 3.0-
MB L3 cache, 35 W)

680645-001

Intel Core i3-3110M 2.40-GHz processor (1600-MHz FSB, 3.0-MB L3 cache, 35 W) 682417-001

Before removing the processor, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Bluetooth module (see Bluetooth module on page 48)

c. Speaker assembly (see Speaker assembly on page 50)

d. Optical drive (see Optical drive on page 51)

e. Hard drive (see Hard drive on page 52)

f. Fan (see Fan on page 54)

g. WWAN module (see WWAN module on page 55)

h. Modem module (see Modem module on page 62)

i. Keyboard (see Keyboard on page 63)

j. Base enclosure (see Base enclosure on page 68)

k. System board (see System board on page 73)

l. Heat sink (see Heat sink on page 75)
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Remove the processor:

1. Use a flat-bladed screw driver (1) to turn the processor locking screw one-half turn
counterclockwise, until you hear a click.

2. Lift the processor (2) straight up, and remove it.

NOTE: The gold triangle (3) on the processor must be aligned with the triangle icon (4)
embossed on the processor socket when you install the processor.

Reverse this procedure to install the processor.
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Fingerprint reader board

Description Spare part number

Fingerprint reader board (includes bracket and cable) 685410-001

Before removing the fingerprint reader board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Bluetooth module (see Bluetooth module on page 48)

c. Speaker assembly (see Speaker assembly on page 50)

d. Optical drive (see Optical drive on page 51)

e. Hard drive (see Hard drive on page 52)

f. Fan (see Fan on page 54)

g. WWAN module (see WWAN module on page 55)

h. Modem module (see Modem module on page 62)

i. Keyboard (see Keyboard on page 63)

j. Base enclosure (see Base enclosure on page 68)

Remove the fingerprint reader board:

1. Remove the Phillips PM2.0×3.6 screw (1) that secures the fingerprint reader board bracket to the
top cover.

2. Remove the fingerprint reader board bracket (2).
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3. Remove the fingerprint reader board and cable (3).

Reverse this procedure to install the fingerprint reader board.

Top cover

NOTE: The top cover spare part kit includes the TouchPad and TouchPad cable. The TouchPad cable
is also available in the Cable Kit, spare part number 651384-001.

Description Spare part number

For use on computer models equipped with a fingerprint reader 685407-001

For use on computer models not equipped with a fingerprint reader 685406-001

Before removing the top cover, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Bluetooth module (see Bluetooth module on page 48)
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c. Speaker assembly (see Speaker assembly on page 50)

d. Optical drive (see Optical drive on page 51)

e. Hard drive (see Hard drive on page 52)

f. Fan (see Fan on page 54)

g. WWAN module (see WWAN module on page 55)

h. Modem module (see Modem module on page 62)

i. Keyboard (see Keyboard on page 63)

j. Base enclosure (see Base enclosure on page 68)

k. System board (see System board on page 73)

NOTE: When replacing the top cover, be sure that the following components are removed from the
defective top cover and installed on the replacement top cover:

● Fingerprint reader board (see Fingerprint reader board on page 80)

● Function button board (see Function button board on page 83)

● Power button board (see Power button board on page 85)

● Smart Card reader assembly (see Smart Card reader assembly on page 86)

Remove the top cover:

1. Release the wireless antenna cables (1) from the routing channels (2) built into the top cover.

2. Remove the two Phillips PM2.0×7.6 screws (1) that secure the display assembly to the top cover.
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3. Swing the display hinges (2) up and back until the top cover is free for removal.

4. Slide the top cover forward (3).

5. Remove the top cover (4).

Reverse this procedure to install the top cover.

Function button board

Description Spare part number

Function button board (includes cable) 685409-001

Before removing the function button board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Bluetooth module (see Bluetooth module on page 48)

c. Speaker assembly (see Speaker assembly on page 50)
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d. Optical drive (see Optical drive on page 51)

e. Hard drive (see Hard drive on page 52)

f. Fan (see Fan on page 54)

g. WWAN module (see WWAN module on page 55)

h. Modem module (see Modem module on page 62)

i. Keyboard (see Keyboard on page 63)

j. Base enclosure (see Base enclosure on page 68)

k. System board (see System board on page 73)

l. Top cover (see Top cover on page 81)

Remove the function button board:

1. Position the top cover with the top edge toward you.

2. Press down on the bottom edge (1) of the retention bracket, and then slide the top edge of the
bracket (2) out of the top cover.

NOTE: The retention bracket is included in the Bracket Kit, spare part number 651381-001.

3. Remove the Phillips PM2.0×3.6 screw (3) that secures the function button board to the top cover.

4. Remove the function button board (4) and cable.

Reverse this procedure to install the function button board.
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Power button board

Description Spare part number

Power button board (includes cable) 685408-001

Before removing the power button board, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Bluetooth module (see Bluetooth module on page 48)

c. Speaker assembly (see Speaker assembly on page 50)

d. Optical drive (see Optical drive on page 51)

e. Hard drive (see Hard drive on page 52)

f. Fan (see Fan on page 54)

g. WWAN module (see WWAN module on page 55)

h. Modem module (see Modem module on page 62)

i. Keyboard (see Keyboard on page 63)

j. Base enclosure (see Base enclosure on page 68)

k. System board (see System board on page 73)

l. Top cover (see Top cover on page 81)

Remove the power button board:

1. Position the top cover with the top edge toward you.

2. Release the tape (1) the secures the power button board cable to the top cover.

3. Remove the Phillips PM2.0×3.6 screw (2) that secures the power button board to the top cover.

4. Lift the left side of the power button board (3) until it rests at an angle.
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5. Remove the power button board (4) and cable by sliding it up and to the left at an angle.

Reverse this procedure to install the power button board.

Smart Card reader assembly

Description Spare part number

Smart Card reader assembly (includes Smart Card reader cable and function LED board cable) 685503-001

Before removing the Smart Card reader assembly, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Bluetooth module (see Bluetooth module on page 48)

c. Speaker assembly (see Speaker assembly on page 50)

d. Optical drive (see Optical drive on page 51)

e. Hard drive (see Hard drive on page 52)
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f. Fan (see Fan on page 54)

g. WWAN module (see WWAN module on page 55)

h. Modem module (see Modem module on page 62)

i. Keyboard (see Keyboard on page 63)

j. Base enclosure (see Base enclosure on page 68)

k. System board (see System board on page 73)

l. Top cover (see Top cover on page 81)

Remove the Smart Card reader assembly:

1. Release the function LED board (1) from the clips built into the top cover.

2. Release the ZIF connectors to which the TouchPad board cables are connected, and then
disconnect the TouchPad cables (2) and (3) from the Smart Card reader assembly.

3. Release the Smart Card reader assembly cable (4) from the clips (5) built into the top cover.

4. Remove the Phillips PM2.0×2.5 broad head screw (1) that secures the Smart Card reader
assembly to the top cover.
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5. Slide the Smart Card reader assembly (2) to the right to release it from the clips built into the
top cover, and then remove the Smart Card reader assembly (3).

6. If it is necessary to replace the function LED board, release the ZIF connector to which the function
LED board cable is connected, and then disconnect the function LED board cable (1) from the
function LED board.

7. Remove the function LED board (2).

The function LED board is available using spare part number 685509-001.

Reverse this procedure to install the Smart Card reader assembly and function LED board.
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Display assembly subcomponents

NOTE: The display assembly is spared at the subcomponent level only. For more display assembly
spare part information, see the individual removal subsections.

To access the display assembly subcomponents, follow these steps:

1. Turn off the computer. If you are unsure whether the computer is off or in Hibernation, turn the
computer on, and then shut it down through the operating system.

2. Disconnect the power from the computer by unplugging the power cord from the computer.

3. Disconnect all external devices from the computer.

4. Remove the battery (see Battery on page 44), and then remove the following components:

a. Service cover (see Service cover on page 46)

b. Bluetooth module (see Bluetooth module on page 48)

c. Speaker assembly (see Speaker assembly on page 50)

d. Optical drive (see Optical drive on page 51)

e. Hard drive (see Hard drive on page 52)

f. Fan (see Fan on page 54)

g. WWAN module (see WWAN module on page 55)

h. Modem module (see Modem module on page 62)

i. Keyboard (see Keyboard on page 63)

j. Base enclosure (see Base enclosure on page 68)

k. System board (see System board on page 73)

l. Top cover (see Top cover on page 81)

1. If it is necessary to replace the display bezel or any of the display assembly subcomponents:

a. Flex the inside edges of the bottom edge (1), the left and right sides (2), and the
top edge (3) of the display bezel until the bezel disengages from the display enclosure.
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b. Remove the display bezel (4).

The display bezel is available using spare part numbers 685411-001 (for use on computer
models equipped with a webcam) and 685412-001 (for use on computer models not
equipped with a webcam).

2. If it is necessary to replace the display panel:

a. Remove the four Phillips PM2.5×5.0 screws (1) and the two Phillips PM2.0×2.5 screws (2)
that secure the display panel to the display enclosure.
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b. Lift the top edge of the display panel and swing it up and forward until it rests at an angle.

c. Release the adhesive support strip (1) that secures the display panel cable to the
display panel.

d. Detach the display panel cable (2) from the surface of display panel. (The display panel
cable is attached to the display panel with double-side adhesive.)
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e. Disconnect the display panel cable (3) from the display panel.

f. Remove the four Phillips PM2.0×3.6 screws (1) that secure the display panel to the display
hinge brackets.

g. Remove the display panel (2).

The display panel is available using spare part number 685504-001.
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3. If it is necessary to replace the webcam/microphone module:

CAUTION: Handle the webcam/microphone module and microphone module with caution.
These modules have a thin profile and are susceptible to damage when not handled carefully.

a. Remove the webcam/microphone module shield (1) from the webcam/microphone module
and display enclosure. (The webcam/microphone module shield is attached to the webcam/
microphone module and display enclosure with double-sided tape.)

b. Disconnect the webcam/microphone module cable (2) from the webcam/
microphone module.

c. Remove the webcam/microphone module (3).

The webcam/microphone module is available using spare part number 685413-001. The
microphone module is available using spare part number 694675-001.

4. If it is necessary to replace the display hinges, display hinge covers, and/or display hinge caps:

a. Remove the display hinge caps (1) from the display hinges.

b. Remove the two Phillips PM2.0×3.6 screws (2) that secure the display hinge covers to the
display hinges.
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c. Remove the display hinge covers (3) from the display hinges.

The display hinges are included in the Display Hinge Kit, spare part number 685414-001.

The display hinge covers and display hinge caps are included in the Display Hinge Cover
Kit, spare part number 685405-001.

5. If it is necessary to replace the display clutch cover:

a. Remove the three Phillips PM2.0×3.6 screws (1) that secure the display clutch cover to the
display enclosure.

b. Release the display clutch cover (2) from the display enclosure.
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c. Release the wireless antenna cables (3) and display panel cable (4) from the display clutch
cover, making note of the locations of the display cable guides (5) at the left and right ends
of the display clutch cover.

d. Remove the display clutch cover.

The display clutch cover is included in the Display Hinge Cover Kit, spare part number
685405-001.

6. If it is necessary to replace the display panel cable:

a. Disconnect the display panel cable (1) from the webcam/microphone module.

b. Detach the display panel cable (2) from the surface of display enclosure. (The display panel
cable is attached to the display enclosure with double-side adhesive.)
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c. Remove the display panel cable (3).

The display panel cable is included in the Display Cable Kit, spare part number
685417-001.

7. If it is necessary to replace the WLAN antenna cables and transceivers:

a. Detach the WLAN antenna transceivers (1) from the display enclosure. (The WLAN antenna
transceivers are attached to the display enclosure with double-sided tape.)

b. Release the WLAN antenna cables from the clips (2) and routing channels built into the
display enclosure.
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c. Remove the WLAN antenna cables and transceivers (3). The WLAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 685506-001.

8. If it is necessary to replace the WWAN antenna cables and transceivers:

a. Detach the WWAN antenna transceivers (1) from the display enclosure. (The WWAN
antenna transceivers are attached to the display enclosure with double-sided tape.)

b. Release the WWAN antenna cables from the clips (2) and routing channels built into the
display enclosure.
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c. Remove the WWAN antenna cables and transceivers (3). The WWAN antenna cables and
transceivers are included in the Antenna Kit, spare part number 685506-001.

Reverse this procedure to reassemble and install the display assembly.
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5 Computer Setup (BIOS) and
Advanced System Diagnostics

Computer Setup, or Basic Input/Output System (BIOS), controls communication between all the input
and output devices on the system (such as disk drives, display, keyboard, mouse, and printer).
Computer Setup includes settings for the types of peripherals installed, the startup sequence of the
computer, and the amount of system and extended memory.

NOTE: Use extreme care when making changes in Computer Setup. Errors can prevent the computer
from operating properly.

Starting Computer Setup
NOTE: An external keyboard or mouse connected to a USB port can be used with Computer Setup
only if USB legacy support is enabled.

To start Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.
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Using Computer Setup

Navigating and selecting in Computer Setup

To navigate and select in Computer Setup, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

● To select a menu or a menu item, use the tab key and the keyboard arrow keys and then
press enter, or use a pointing device to click the item.

● To scroll up and down, click the up arrow or the down arrow in the upper-right corner of the
screen, or use the up arrow key or the down arrow key.

● To close open dialog boxes and return to the main Computer Setup screen, press esc, and
then follow the on-screen instructions.

NOTE: You can use either a pointing device (TouchPad, pointing stick, or USB mouse) or
the keyboard to navigate and make selections in Computer Setup.

2. Press f10 to enter Computer Setup.

To exit Computer Setup menus, choose one of the following methods:

● To exit Computer Setup menus without saving your changes, click the Exit icon in the lower-left
corner of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.

– or –

● To save your changes and exit Computer Setup menus, click the Save icon in the lower-left corner
of the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Save Changes and Exit, and then
press enter.

Your changes go into effect when the computer restarts.
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Restoring factory settings in Computer Setup

NOTE: Restoring defaults will not change the hard drive mode.

To return all settings in Computer Setup to the values that were set at the factory, follow these steps:

1. Turn on or restart the computer, and then press esc while the “Press the ESC key for Startup Menu”
message is displayed at the bottom of the screen.

2. Press f10 to enter Computer Setup.

3. Use a pointing device or the arrow keys to select File > Restore Defaults.

4. Follow the on-screen instructions.

5. To save your changes and exit, click the Save icon in the lower-left corner of the screen, and then
follow the on-screen instructions.

– or –

Use the arrow keys to select File > Save Changes and Exit, and then press enter.

Your changes go into effect when the computer restarts.

NOTE: Your password settings and security settings are not changed when you restore the
factory settings.

Updating the BIOS
Updated versions of the BIOS may be available on the HP Web site.

Most BIOS updates on the HP Web site are packaged in compressed files called SoftPaqs.

Some download packages contain a file named Readme.txt, which contains information regarding
installing and troubleshooting the file.

Determining the BIOS version

To determine whether available BIOS updates contain later BIOS versions than those currently installed
on the computer, you need to know the version of the system BIOS currently installed.

BIOS version information (also known as ROM date and System BIOS) can be displayed as follows:

1. Start Computer Setup.

2. Use a pointing device or the arrow keys to select File > System Information.

3. To exit Computer Setup without saving your changes, click the Exit icon in the lower-left corner of
the screen, and then follow the on-screen instructions.

– or –

Use the tab key and the arrow keys to select File > Ignore Changes and Exit, and then
press enter.
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NOTE: You can also determine the BIOS version by turning on or restarting the computer, pressing
the esc key while the “Press the ESC key for Startup Menu” message is displayed at the bottom of the
screen, and then pressing the f1 key. Follow the on-screen instructions to exit this screen.

Downloading a BIOS update

CAUTION: CAUTION: To reduce the risk of damage to the computer or an unsuccessful installation,
download and install a BIOS update only when the computer is connected to reliable external power
using the AC adapter. Do not download or install a BIOS update while the computer is running on
battery power, docked in an optional docking device, or connected to an optional power source.
During the download and installation, follow these instructions:

Do not disconnect power from the computer by unplugging the power cord from the AC outlet.

Do not shut down the computer or initiate Suspend or Hibernation.

Do not insert, remove, connect, or disconnect any device, cable, or cord.

1. Open your Web browser. For U.S. support, go to http://www.hp.com/go/contactHP.
For worldwide support, go to http://welcome.hp.com/country/us/en/wwcontact_us.html.

2. Follow the on-screen instructions to identify your computer and access the BIOS update you want
to download.

3. Click the option for software and driver downloads, type your computer model number in the
product box, and then press enter. Follow the on-screen instructions to identify your computer and
access the BIOS update you want to download.

4. Click your specific product from the models listed.

5. Click the appropriate operating system.

6. Go to the BIOS section and download the BIOS software package.

7. Follow the installation instructions as provided with the downloaded BIOS software package.

NOTE: After a message on the screen reports a successful installation, you can delete the
downloaded file from your hard drive.
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Using Advanced System Diagnostics
Advanced System Diagnostics allows you to run diagnostic tests to determine if the computer hardware
is functioning properly. The following diagnostic tests are available in Advanced System Diagnostics:

● Start-up test—This test analyzes the main computer components that are required to start
the computer.

● Run-in test—This test repeats the start-up test and checks for intermittent problems that the start-up
test does not detect.

● Hard disk test—This test analyzes the physical condition of the hard drive, and then checks all
data in every sector of the hard drive. If the test detects a damaged sector, it attempts to move the
data to a good sector.

● Memory test—This test analyzes the physical condition of the memory modules. If it reports an
error, replace the memory modules immediately.

● Battery test—This test analyzes the condition of the battery and calibrates the battery if necessary.
If the battery fails the test, contact support to report the issue and purchase a replacement battery.

● System Tune-Up—This group of additional tests checks your computer to make sure that the main
components are functioning correctly. System Tune-Up runs longer and more comprehensive tests
on memory modules, hard drive SMART attributes, the hard drive surface, the battery (and battery
calibration), video memory, and the WLAN module status.

You can view system information and error logs in the Advanced System Diagnostics window.

To start Advanced System Diagnostics:

1. 1. Turn on or restart the computer. While the “Press the ESC key for Startup Menu” message is
displayed in the lower-left corner of the screen, press esc. When the Startup Menu is displayed,
press f2.

2. Click the diagnostic test you want to run, and then follow the on-screen instructions.

NOTE: If you need to stop a diagnostics test while it is running, press esc.

Using Advanced System Diagnostics 103



6 Specifications

Computer specifications

 Metric U.S.

Dimensions

Width 30.52 cm 12.02 in

Depth 20.90 cm 8.23 in

Height (front to rear) 2.74 to 3.28 cm 1.08 to 1.29 in

Weight (equipped with lightest display assembly, one
memory module, solid-state drive, webcam, 3-cell battery,
and WLAN module)

1.63 kg 3.59 lbs

Input power

Operating voltage and current 18.5 V dc @ 3.5A or 19.5 V dc @ 3.33A – 65W

19 V dc @ 4.74A or 19.5 V dc @ 4.62A – 90W

Temperature

Operating 5°C to 35°C 41°F to 95°F

Nonoperating -20°C to 60°C -4°F to 140°F

Relative humidity (noncondensing)

Operating 10% to 90%

Nonoperating 5% to 95%

Maximum altitude (unpressurized)

Operating -15 m to 3,048 m -50 ft to 10,000 ft

Nonoperating -15 m to 12,192 m -50 ft to 40,000 ft

NOTE: Applicable product safety standards specify thermal limits for plastic surfaces. The device operates well within this
range of temperatures.
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12.5-inch SGA display specifications

 Metric U.S.

Dimensions

Height 15.70 cm 6.18 in

Width 27.80 cm 10.95 in

Diagonal 31.80 cm 12.52 in

Number of colors up to 16.8 million

Contrast ratio 200:1 (typical)

Brightness 200 nits (typical)

Pixel resolution

Pitch 0.197 × 0.197 mm

Format 1366 × 768

Configuration RGB vertical stripe

Backlight LED

Character display 80 × 25

Total power consumption 2.0 W

Viewing angle ±65° horizontal, ±50° vertical (typical)
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Hard drive specifications

 750-GB* 500-GB* 320-GB*

Dimensions

Height 9.5 mm 9.5 mm 9.5 mm

Length 100.2 mm 100.4 mm 100.4 mm

Width 69.9 mm 69.9 mm 69.9 mm

Weight 110 g 110 g 110 g

Interface type SATA SATA SATA

Transfer rate

Synchronous (maximum) 1.1 GB/sec 1.1 GB/sec 1.1 GB/sec

Security ATA security ATA security ATA security

Seek times (typical read, including setting)

Single track 2.0 ms 1.5 ms 1.5 ms

Average (read/write) 12/16 ms 11/13 ms 11/13 ms

Maximum 22 ms 22 ms 22 ms

Logical blocks 1,465,149,168 976,773,168 628,142,448

Disk rotational speed 7200 rpm 7200 rpm 7200 rpm

Operating temperature 0°C to 60°C (32°F to 140°F)

*1 GB = 1 billion bytes when referring to hard drive storage capacity. Actual accessible capacity is less.

NOTE: Certain restrictions and exclusions apply. Contact technical support for details.
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7 Backup and recovery

To protect your information, use Windows Backup and Restore to back up individual files and folders,
back up your entire hard drive (select models only), create system repair discs (select models only) with
the installed optical drive (select models only) or an optional external optical drive, or create system
restore points. In case of system failure, you can use the backup files to restore the contents of
your computer.

Windows Backup and Restore provides the following options:

● Creating a system repair disc (select models only) by using the installed optical drive (select
models only) or an optional external optical drive

● Backing up your information

● Creating a system image (select models only)

● Scheduling automatic backups (select models only)

● Creating system restore points

● Recovering individual files

● Restoring the computer to a previous state

● Recovering information using recovery tools

NOTE: For detailed instructions, perform a search for these topics in Help and Support.

In case of system instability, HP recommends that you print the recovery procedures and save them for
later use.

NOTE: Windows includes the User Account Control feature to improve the security of your computer.
You may be prompted for your permission or password for tasks such as installing software, running
utilities, or changing Windows settings. See Help and Support for more information.
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Creating recovery media with HP Recovery
Disc Creator

HP Recovery Disc Creator is a software program that offers an alternative way to create recovery
media. After you successfully set up the computer, you can create recovery media using HP Recovery
Disc Creator. This recovery media allows you to reinstall your original operating system as well as
select drivers and applications if the hard drive becomes corrupted.

HP Recovery Disc Creator can create two kinds of recovery DVDs as follows:

● Windows DVD—Installs the operating system without additional drivers or applications.

● Driver DVD—Installs specific drivers and applications only, in the same way that the HP Software
Setup utility installs drivers and applications.

Creating recovery media

NOTE: The Windows DVD can be created only once. Thereafter, the option to create that media will
not be available.

1. Select Start > All Programs > Productivity and Tools > HP Recovery Disc Creator.

2. Select Driver DVD or Windows DVD.

3. From the drop-down menu, select the drive for burning the recovery media.

4. Click the Burn button to start the burning process.

Backing up your information
Recovery after a system failure is as good as your most recent backup. Immediately after setting up the
computer, you should create system repair discs (select models only) using the installed optical drive
(select models only) or an optional external optical drive and back up your system. As you add new
software and data files, you should continue to back up your system on a regular basis to maintain a
reasonably current backup. The system repair discs (select models only) are used to start up (boot) the
computer and repair the operating system in case of system instability or failure. Your initial and
subsequent backups allow you to restore your data and settings if a failure occurs.

You can back up your information to an optional external hard drive, a network drive, or discs.

Note the following when backing up:

● Store personal files in the Documents library, and back it up regularly.

● Back up templates that are stored in their associated programs.

● Save customized settings that appear in a window, toolbar, or menu bar by taking a screen shot
of your settings. The screen shot can be a time-saver if you have to reset your preferences.
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● When backing up to discs, use any of the following types of discs (purchased separately): CD-R,
CD-RW, DVD+R, DVD+R DL, DVD-R, DVD-R DL, or DVD±RW. The discs you use will depend on the
type of optical drive you are using.

NOTE: DVDs and DVDs with double-layer (DL) support store more information than CDs, so
using them for backup reduces the number of recovery discs required.

● When backing up to discs, number each disc before inserting it into the external drive.

To create a backup using Backup and Restore:

NOTE: Be sure that the computer is connected to AC power before you start the backup process.

NOTE: The backup process may take over an hour, depending on file size and the speed of
the computer.

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to set up your backup, create a system image (select models
only), or create a system repair disc (select models only).

Performing a system recovery
In case of system failure or instability, the computer provides the following tools to recover your files:

● Windows recovery tools: You can use Windows Backup and Restore to recover information you
have previously backed up. You can also use Windows Startup Repair to fix problems that might
prevent Windows from starting correctly.

● f11 recovery tools: You can use the f11 recovery tools to recover your original hard drive image.
The image includes the Windows operating system and software programs installed at the factory.

NOTE: If you are unable to boot (start up) your computer and you cannot use the system repair discs
you previously created (select models only), you must purchase a Windows 7 operating system DVD to
reboot the computer and repair the operating system. For additional information, see the Using a
Windows 7 operating system DVD (purchased separately) section.

Using the Windows recovery tools

To recover information you previously backed up:

1. Select Start > All Programs > Maintenance > Backup and Restore.

2. Follow the on-screen instructions to recover your system settings, your computer (select models
only), or your files.

To recover your information using Startup Repair, follow these steps:
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CAUTION: Some Startup Repair options completely erase hard drive contents and reformat the hard
drive. All files you have created and any software installed on the computer are permanently removed.
When reformatting is complete, the recovery process restores the operating system, as well as the
drivers, software, and utilities from the backup used for recovery.

1. If possible, back up all personal files.

2. If possible, check for the presence of the Windows partition.

To check for the Windows partition, select Start > Computer.

3. If the Windows partition is listed, restart the computer, and then press f8 before the Windows
operating system loads.

4. Select Startup Repair.

5. Follow the on-screen instructions.

NOTE: For additional information on recovering information using the Windows tools, perform a
search for these topics in Help and Support.

Using f11 recovery tools

CAUTION: Using f11 recovery tools completely erases hard drive contents and reformats the hard
drive. All files you have created and any software installed on the computer are permanently removed.
The f11 recovery tool reinstalls the operating system and HP programs and drivers that were installed at
the factory. Software not installed at the factory must be reinstalled.

To recover the original hard drive image using f11:

1. If possible, back up all personal files.

2. If possible, check for the presence of the HP Recovery partition: click Start, right-click Computer,
click Manage, and then click Disk Management.

NOTE: If the HP Recovery partition has been deleted, the f11 restore option will not function.
You must recover your operating system and programs using the Windows 7 operating system
DVD and the Driver Recovery disc (both purchased separately) if the Windows partition and the
HP Recovery partition are not listed. For additional information, see the Using a Windows 7
operating system DVD (purchased separately) section.

3. If the HP Recovery partition is listed, restart the computer, and then press esc while the “Press the
ESC key for Startup Menu” message is displayed at the bottom of the screen.

4. Press f11 while the “Press <F11>” for recovery” message is displayed on the screen.

5. Follow the on-screen instructions.
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Using a Windows 7 operating system DVD (purchased separately)

To order a Windows 7 operating system DVD, go to the HP website. For U.S. support, go to
http:// www.hp.com/go/contactHP. For worldwide support, go to http://welcome.hp.com/country/
us/en/ wwcontact_us.html. You can also order the DVD by calling support. For contact information,
see the Worldwide Telephone Numbers booklet included with the computer.

CAUTION: Using a Windows 7 operating system DVD completely erases hard drive contents and
reformats the hard drive. All files you have created and any software installed on the computer are
permanently removed. When reformatting is complete, the recovery process helps you restore the
operating system, as well as drivers, software, and utilities.

To initiate recovery using a Windows 7 operating system DVD:

NOTE: This process takes several minutes.

1. If possible, back up all personal files.

2. Restart the computer, and then insert the Windows 7 operating system DVD into the optical drive
before the Windows operating system loads.

3. When prompted, press any keyboard key.

4. Follow the on-screen instructions.

5. Click Next.

6. Select Repair your computer.

7. Follow the on-screen instructions.

After the repair is completed:

1. Eject the Windows 7 operating system DVD, and then insert the Driver Recovery disc.

2. Install the Hardware Enabling Drivers first, and then install Recommended Applications.
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8 Power cord set requirements

The wide-range input feature of the computer permits it to operate from any line voltage from 100 to
120 volts AC, or from 220 to 240 volts AC.

The 3-conductor power cord set included with the computer meets the requirements for use in the
country or region where the equipment is purchased.

Power cord sets for use in other countries and regions must meet the requirements of the country or
region where the computer is used.

Requirements for all countries
The following requirements are applicable to all countries and regions:

● The length of the power cord set must be at least 1.5 m (5.0 ft) and no more than 2.0 m (6.5 ft).

● All power cord sets must be approved by an acceptable accredited agency responsible for
evaluation in the country or region where the power cord set will be used.

● The power cord sets must have a minimum current capacity of 10 amps and a nominal voltage
rating of 125 or 250 V AC, as required by the power system of each country or region.

● The appliance coupler must meet the mechanical configuration of an EN 60 320/IEC 320
Standard Sheet C13 connector for mating with the appliance inlet on the back of the computer.
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Requirements for specific countries and regions

Country/region Accredited agency Applicable note number

Australia EANSW 1

Austria OVE 1

Belgium CEBC 1

Canada CSA 2

Denmark DEMKO 1

Finland FIMKO 1

France UTE 1

Germany VDE 1

Italy IMQ 1

Japan METI 3

The Netherlands KEMA 1

Norway NEMKO 1

The People's Republic of China COC 5

South Korea EK 4

Sweden SEMKO 1

Switzerland SEV 1

Taiwan BSMI 4

The United Kingdom BSI 1

The United States UL 2

1. The flexible cord must be Type HO5VV-F, 3-conductor, 1.0-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

2. The flexible cord must be Type SPT-3 or equivalent, No. 18 AWG, 3-conductor. The wall plug must be a two-pole
grounding type with a NEMA 5-15P (15 A, 125 V) or NEMA 6-15P (15 A, 250 V) configuration.

3. The appliance coupler, flexible cord, and wall plug must bear a “T” mark and registration number in accordance with the
Japanese Dentori Law. The flexible cord must be Type VCT or VCTF, 3-conductor, 1.00-mm² conductor size. The wall plug
must be a two-pole grounding type with a Japanese Industrial Standard C8303 (7 A, 125 V) configuration.

4. The flexible cord must be Type RVV, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

5. The flexible cord must be Type VCTF, 3-conductor, 0.75-mm² conductor size. Power cord set fittings (appliance coupler
and wall plug) must bear the certification mark of the agency responsible for evaluation in the country or region where it
will be used.

Requirements for specific countries and regions 113



9 Recycling

When a non-rechargeable or rechargeable battery has reached the end of its useful life, do not dispose
of the battery in general household waste. Follow the local laws and regulations in your area for
battery disposal.

HP encourages customers to recycle used electronic hardware, HP original print cartridges, and
rechargeable batteries. For more information about recycling programs, see the HP Web site at
http://www.hp.com/recycle.
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base enclosure
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removal 48
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Bluetooth module cable,
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Bracket Kit, spare part number
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button components 9
buttons

keyboard light 8

pointing stick 12
power 9
TouchPad 12
TouchPad on/off 12
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Cable Kit
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computer major components 21
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DisplayPort 16
docking connector 16
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removal 88
spare part number 23, 35, 88

G
graphics, product description 1
grounding guidelines 38
guidelines

equipment 41
grounding 38
packaging 40
transporting 40
workstation 40

H
hard drive
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product description 2
removal 52
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specifications 106

hard drive bracket
illustrated 29
removal 53
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illustrated 29
removal 53
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contents 29
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headphone 16
microphone 16
modem 14
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key components 10

keyboard
product description 4
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microphone
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microphone module
removal 93
spare part number 27, 35, 93

model description 43
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modem jack 14
modem module

removal 62
spare part number 24, 33, 62

modem module cable, illustrated
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monitor port 15
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mute light 11
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operating system, product

description 5
optical drive
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product description 2
removal 51
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pointing stick button 12
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power button 9
power button board

removal 85
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power cord

set requirements 112
spare part numbers 31, 32

power light 11, 13
power requirements, product
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product description 1
removal 78
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RJ-11 jack plug, illustrated 30
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removal 66
spare part number 23, 33, 66

Rubber Kit, spare part number
24, 33

S
Screw Kit, spare part number 32,

35
security cable slot 16
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serial number 42
service considerations

cables 37
connectors 37
plastic parts 37

service cover
location 17
removal 46
spare part number 25, 34, 46

service cover release latch 17
service tag 20, 42
serviceability, product description

6
SIM slot, location 17
SIM, removal 45
Smart Card reader assembly

removal 86
spare part number 23, 35, 86

Smart Card reader, location 14
solid-state drive

precautions 38
product description 2
spare part numbers 25, 29,

36
speaker assembly

removal 50
spare part number 24, 33, 50

speaker, location 18
specifications
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display 105
hard drive 106

system board
removal 73
spare part numbers 23, 34,

35, 73
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top cover

removal 81
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81
TouchPad button 12
TouchPad components 12
TouchPad light 11
TouchPad on/off button 12
TouchPad zone 12
transporting guidelines 40
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USB 3.0 port 15
USB port 15

V
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video, product description 2
volume mute button 10

W
warranty period 43
web browser button 10
web browser light 11
webcam 8
webcam light 7
webcam/microphone module

removal 93
spare part number 27, 34, 93

Windows applications key 10
Windows logo key 10
wireless antenna
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removal 96, 97
spare part number 27, 35,
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Wireless Antenna Kit, spare part

number 97
wireless button 9
wireless light 11, 13
wireless, product description 3
WLAN module

removal 59
spare part numbers 24, 33,
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workstation guidelines 40

WWAN module
removal 55
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34, 55
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